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Introduction 
QuickBooks Integration with timeQplus V4 software allows you to save valuable time by limiting the 
amount of manual entry that occurs during payroll processing. With QuickBooks Integration, you will 
be able to import your employee information from QuickBooks, export the employee time data 
(including Work Code data) into QuickBooks, and add employee information to QuickBooks from 
timeQplus. Importing employee data from QuickBooks can be done through the timeQplus server or 
any timeQplus client installation. 
 
timeQplus-QuickBooks Integration is compatible with QuickBooks Pro and Premier 2002 and up to 
and including the most recent versions. timeQplus Integration does not work with the Basic version 
of QuickBooks. timeQplus must be able to access the QuickBooks Company File in order to perform 
the integration (timeQplus must be able to browse the Company File from My Computer). The 
Company File can reside either on the local machine or a shared location on the same network with a 
mapped drive. 
 

Please note that screen shots shown in this document were taken from a QuickBooks Pro 
2013 application.  Other versions of QuickBooks Pro and/or Premier will likely have somewhat 

different screens. 



 
 

06-0423-000 Rev. A 3

Table of Contents 
 
Introduction ...........................................................................................................................................2 

Importing from QuickBooks Pro/Premium into timeQplus V4................................................................4 

Method 1: Importing Employee Info with the timeQplus Setup Wizard..............................................4 

Method 2: Importing Employees through timeQplus V4 System Utilities...........................................8 

Setting up QuickBooks to use time data from TimeQplus...................................................................13 

Setting Up QuickBooks to accept Work Codes ...................................................................................18 

Exporting from timeQplus into QuickBooks.........................................................................................20 

Reviewing Employee time data in QuickBooks ...................................................................................25 

Appendix .............................................................................................................................................27 

Confirming your QuickBooks Company File Location (2 options)....................................................27 

Obtaining the QuickBooks Payroll Item Codes................................................................................30 

Allowing timeQplus to always access QuickBooks..........................................................................33 

Troubleshooting ..................................................................................................................................35 
 



 
 

06-0423-000 Rev. A 4

Importing from QuickBooks Pro/Premium into timeQplus V4 
(There is a separate document for timeQplus V3 and V2) 

 
There are two methods for importing employee data from QuickBooks into timeQplus.  If you are just 
setting up timeQplus, you can use Method 1 to import your employee information using the 
timeQplus Setup Wizard.  If you have already been using timeQplus and would like to interface with 
QuickBooks, follow Method 2 for importing employee information.   

Note: This step IS NOT a requirement for exporting successfully to QuickBooks. 
 
While QuickBooks accepts employees’ middle names spelled out, or as an initial with or without 
punctuation, timeQplus software only accepts employees’ names  in the following format: First 
Name, Middle Initial (with no punctuation) and Last Name.  To ensure a successful import please 
review the middle name field to confirm that it is an initial without punctuation.  
 

Method 1: Importing Employee Info with the timeQplus Setup Wizard  
 At the end of the timeQplus Setup Wizard process, you will be asked how you would like to enter 
your employees.  Select the second option for “Import Employees from Intuit QuickBooks” as shown 
in Figure 1-1.  

Note: You must also be logged into QuickBooks as a single user with administrator privileges 
and the company file must be open with all work windows closed.   

 
Click Next and then Finish on the next screen. 
 
Figure 1-1 
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Select your Company File (Acroprint Time Recorder Company is used as an example) as shown in 
Figure 1-2.  Refer to the Appendix if you have difficulty locating this file. 
 
Figure 1-2 

 
 
Highlight the Company File.  Click Open to begin the import.  QuickBooks will prompt you with a 
security warning as shown in Figure 1-3.   
 
You must select one of the “Yes” choices to continue. It is recommended to select “Yes, always; allow 
access even if QuickBooks is not running”.  In the future, this will allow you to import from and export 
to QuickBooks without QuickBooks being open. 
 



 
 

06-0423-000 Rev. A 6

Figure 1-3 

 
 
Click “Yes, always; allow access even if QuickBooks is not running”, then click Continue and you will 
see the “Confirm to Proceed” window shown in Figure 1-4. 
 
 
Figure 1-4 

 
 
Select “Yes” and Figure 1-5 will appear. 
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Figure 1-5 

 
 
Select Done, then Figure 1-6 will display.   
 
 
Figure 1-6 

 
 
Your importing setup is complete. 
 
Click OK. 
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Method 2: Importing Employees through timeQplus V4 System Utilities 
You must be logged in as an Administrator! 

 
 

Click File from the menu bar, and then click on System Utilities. (Fig 2-1) 
 
Figure 2-1 
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On the System Utilities screen (Figure 2-2) click the Import QuickBooks button. 
 
Figure 2-2 
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Select your Company File (*.qbw) as shown in Figure 2-3.  Refer to the Appendix if you have 
difficulty locating this file.    
 
Figure 2-3 

 
 
 
Click “Open” to begin the import.  QuickBooks will prompt you with a security warning as shown in 
Figure 2-4. It is recommended to select “Yes, always; allow access even if QuickBooks is not 
running”. In the future, this will allow you to import from and export to QuickBooks without 
QuickBooks being open. 
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Figure 2-4 

 
 
 
Selecting Yes, always; allow access even if QuickBooks is not running will display the message 
shown in Figure 2-5. 
 
Figure 2-5 

 
 
Select Yes to continue and Figure 2-6 will appear. 
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Figure 2-6 

 
 
Select Done and Figure 2-7 will appear. 
 
 
Figure 2-7 

 
 
Your importing setup is complete. 
 
Click OK. 
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Setting up QuickBooks to use time data from TimeQplus 
In order for QuickBooks to accept time data for payroll, you must enable Time Tracking.  Click on Edit 
and select Preferences. 
 
In the Preferences window (Figure 3-1), click Time & Expenses on the left navigation panel and then 
click on the Company Preferences tab.  Click “Yes” for the question “Do You Track Time?”  You must 
select a first day of your work week.  You may elect to make other selections on this screen based on 
your company requirements. 
 
Figure 3-1 

 
 
Now you will need to set the Employee Defaults to use time data to create paychecks.  This will 
ensure that all new employees will have this feature enabled automatically. Select Payroll & 
Employees as shown in Figure 3-2.   
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Figure 3-2 

 
 
On the Company Preferences tab, then click Employee Defaults and the following screen will appear. 
 
Figure 3-3 
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Place a check in the “Use time data to create paychecks” checkbox as shown in Figure 3-3. 
Click OK to close the Employee Defaults window.   
Click OK to close the Preferences window. 
 
You will now need to change all of your existing employees to use time data as well.  Select 
Employees and then Employee Center.  A list of your employees will be presented as in Figure 3-4. 
 
 
Figure 3-4 
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Double click on an employee and the Edit Employee screen will appear (Figure 3-5) 
 
Figure 3-5 
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Choose Payroll Info from the left navigation bar and Fig 3-6 will appear.  
 
Figure 3-6 

 
 
Click in the checkbox to enable “Use time data to create paychecks” as shown above. 
 
Click OK to go back to the Employee List and perform this process for each employee on the list. 
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Setting Up QuickBooks to accept Work Codes 
 
If you will be using the Work Codes feature in timeQplus, you must setup QuickBooks to allow the 
time data to successfully export from timeQplus to QuickBooks. 
 

Note: It may be useful to print a list of work code names before entering this information in 
QuickBooks. 

 
Open QuickBooks and click on Customers [either from the left navigation panel or from the diagram] 
as shown on Figure 4-1 below. 
 
Figure 4-1 
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Now click on New Customer & Job, then New Customer as shown in Figure 4-2 below. 
 

 
The following input screen (Figure 4-3) will appear. In the Customer Name field, type the Work Code 
name exactly as it appears in timeQplus (including capital letters). In the example, the Work Code 
name is “WC3”.  Make no other changes on this screen. Then click the “OK” button. 
 
Repeat this process until all the Work Codes are added to QuickBooks in this manner. 
 
Figure 4-3 
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Exporting from timeQplus into QuickBooks 
You must be logged in as an Administrator! 

 
After you have completed your first pay period, you will be able to export your employee information 
and employee time data into QuickBooks Pro or Premier.  Click on Export on the left hand menu. 
 
As shown in Figure 5-1, set the Pay Periods drop down to the Previous pay period.  Select the 
employees you want to export; either All Employees, Individual Employee(s) or an Individual Shift.  
Set the Output Format to QuickBooks Integration.   Click Setup to begin the QuickBooks Integration 
setup. 
 
Figure 5-1 

 
 
The Setup screen is seen in Figure 5-2.   
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Figure 5-2 

 
 

1) Enter the Payroll Item Codes for timeQplus.  It is recommended to have QuickBooks open at this 
time and copy and paste from QuickBooks into the setup screen.  If there is no corresponding 
entry in QuickBooks, be sure to clear the entry fields in the timeQplus QuickBooks Integration 
setup screen.  Make sure that all fields are identical in QuickBooks and timeQplus even if they are 
blank. 
 

2) Press Select to choose your QuickBooks Company File. After the folder is located, click to 
highlight the file and then click the Open button. Click Save to save your QuickBooks Integration 
settings. See Figure 5-3 for an example. If you need any additional help in getting this file and/or 
getting the Payroll Item Codes, please refer to the Appendix or QuickBooks literature. 
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Figure 5-3 

 
 
You will then be brought back to Figure 5-4.  Click the Export button.  
 
Figure 5-4 
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QuickBooks will prompt you with a security warning as shown in Figure 5-5.  It is recommended to 
select Yes, always; allow access even if QuickBooks is not running.  This will allow you to export to 
QuickBooks without QuickBooks being open. 
 
Figure 5-5 

 
 
Selecting Yes, always; allow access even if QuickBooks is not running will display the message 
shown in Figure 5-6. 
 
Figure 5-6 

 
 
Select Yes to continue and Figure 5-7 will appear. 
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Figure 5-7 

 
 
An export progress monitor will display, advising if a successful export upon completion.  If there is 
not a successful completion, review these instructions again and/or check the Trouble Shooting 
section.  If still not successful, you can contact Acroprint Customer Service.  Be advised that there 
may be a fee associated with assistance from Acroprint. 
 
Time worked will now show in Employee’s Weekly Timecard in QuickBooks.   
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Reviewing Employee time data in QuickBooks 
 
To review and confirm that employee time data was successfully exported to QuickBooks, click on 
Employees, then Enter Time from the menu bar, or click on Enter Time from the Home screen 
diagram found in the Employees section as shown on Figure 6-1 below. 
 
Figure 6-1 

 
 
Now click on Use Weekly Timesheet as shown in Figure 6-2 below. 
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Figure 6-2 
 

 
 
Now select the employee from the drop down list, and then click the calendar icon to select  
any date within the pay period of interest.  See Figure 6-3 below. 
 
Figure 6-3 
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Appendix 

Confirming your QuickBooks Company File Location (2 options) 
 
Option 1 
 
Click File > Open Previous Company 
 
Figure A-1 

 
 
The top of the list is the full address of where the company file is located.   
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Option 2 
 
Click File > Open or Restore Company 
 
Figure A-2 

 
 
In Figure A-3 you can see that our test file is named Acroprint Time Recorder Company.qbw.  Click 
the down arrow in the Look In: drop down menu to see/record the file path (Fig. A-4) 
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Figure A-3 

 
 
Figure A-4 shows the Company File is located at C:\QuickBooks\Company Files\Acroprint Time 
Recorder Company 
 
 
Figure A-4 
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Obtaining the QuickBooks Payroll Item Codes 
timeQplus has default payroll item codes for each of the following categories (Figure B-1): 

• Regular Pay Code 
• Overtime Level 1 Pay Code 
• Overtime Level 2 Pay Code 
• Vacation Pay Code 

• Holiday Pay Code 
• Sick Pay Code 
• Other Pay Code 

 
 
Figure B-1 

 
 
 
To locate Payroll Item Codes in QuickBooks, follow these instructions: 
 
Click Edit, and then Preferences, as shown in Figure B-2. 
 
Figure B-2 
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Figure B-3 will be presented. 
 
Figure B-3 

 
 
Click Payroll & Employees and then click the Company Preferences tab.   Now 
click the Employee Defaults button.   
 
In Figure B-4, click in the field directly under the Item Name to add, delete or edit 
Payroll Item Code names. 
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Figure B-4 

 
 
Each of the pay categories in timeQplus has a Payroll Item Code and they must 
be exactly the same in QuickBooks.  Print out the screen or write down these 
Payroll Item Codes to enter it into timeQplus or QuickBooks. 
 

Note: The Payroll Item Codes are case-sensitive. 
 
If there are further questions regarding this process, please consult your 
QuickBooks documentation for instructions on how to add, delete and edit them. 
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Allowing timeQplus to always access QuickBooks 
In order for timeQplus to access QuickBooks without QuickBooks being open, 
you must give timeQplus Permission to always access QuickBooks. 
 
Click Edit > Preferences as shown in Figure C-1. 
 
Figure C-1 
 
 
 
 
 
 
 
 
 
 
 
 
Click on Integrated Applications and go to the Company Preferences tab as 
shown in Figure C-2.   
 
Be sure that neither of the check boxes on this screen is checked.   
 
timeQplus should have a check in the Allow Access column.  Highlight timeQplus 
and select Properties. 
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Figure C-2 

 
 
Check the “Allow this application to access this company file” check box and the 
“Allow this application to login automatically” check box as shown in Figure C-3. 
 
Figure C-3 

 
 
Click OK to close the Properties window.  Click OK to close the Preferences 
window.   
 
You will no longer be required to be logged into QuickBooks to perform the 
timeQplus Integration. 
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Troubleshooting 
Error Solution 

“The Company File couldn’t 
be found or QuickBooks will 
not allow timeQplus to 
access File. You must 
launch QuickBooks and then 
return to timeQplus and retry 
the export” 

Be sure QuickBooks is accessing the correct 
Company File and that QuickBooks is allowing 
files to access it. timeQplus does not allow the 
file name to contain commas and special 
characters. Check that QuickBooks is open as 
an Admin/Single User with all other work 
windows closed. 

“The following employees 
were found in timeQplus but 
were not Found in 
QuickBooks.” 

If you manually entered the Employee Names, 
make sure all of your names are spelled and 
capitalized exactly as they are in QuickBooks 
including Middle Initials. Additionally, 
QuickBooks accepts employees’ middle names 
spelled out, or as an initial with or without 
punctuation, while timeQplus only allows for 
one (1) initial with no punctuation. It must be 
John A Smith is not John A. Smith. 

The time exported from 
timeQplus does not match 
the time that shows up in 
QuickBooks. 

Verify the time totals format in timeQplus. You 
may have timeQplus set in Hundredths while 
QuickBooks displays in hours and minutes. 
Verify the pay periods have the same start 
and/or end dates in both applications. 

Edited totals are not showing 
up correctly in QuickBooks. 

If the total number of hours in one edit is 
greater than 24, the hours will not show up 
correctly. Large edits should be done on a per 
day basis within the punch editor. Editing of 
totals should account for small blocks of time 
added or subtracted at the end of the week. 
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